





SECTION-II (2 MARK)

16. What are the types of page orientation? Write the default page orientation.
v’ Page orientation refers to how the document will be displayed on screen and printed.
v There are two different orientations: Portrait and Landscape.
Landscape:-
v The width of the document is more than the height.
v This is best suited for displaying professional photos, invitations, albums, tables etc.
Portrait:-
v" This is the most common and default orientation.
v" Here, the height of the document is more than the width.
v Normally books, newspapers will be displayed in this format.
17. Write notes on 1975- 1980 period of computer generation.

This period of computer generation is Fourth generation.

Microprocessor (VLSI) used as main component in this generation.
These generation computers are smaller and faster.
In this generation microcomputer series such as IBM and Apple were developed.
And portable computers were introduced in this generation.
< Dynamic RAM (DRAM)
18. Convert 11012 to decimal number.
v Answer is 1310
19. What is the use of PS/2 Port?
v' PS/2 Ports are used to connect mouse and keyboard into PC.
20. List some uses of operating System.
The main use of Operating System is:-
To ensure that a computer can be used to extract what the user wants it do.
Easy interaction between the users and computers.
Starting computer operation automatically when power is turned on (Booting).
Controlling Input and Output Devices.
Manage the utilization of main memory.
Providing security to user programs.
21. What is workspace?
v The workspace is the area in the document window to enter or type the text of your document.
22. What are the types of ruler?
v The ruler is a scale below the formatting tool bar which shows the margins.
v" There are two set of rulers (1) Horizontal ruler and (2) Vertical ruler.
v Horizontal ruler is used to set left and right margins of a page.
v" Vertical ruler for top and bottom setting.
23. What is a cell pointer?
v' Cell pointer is a rectangle box which can be moved around the worksheet.
v The cell in which the cell pointer is currently located is known as “Active cell”.
24. What is the use of F11 key?
v F11 key is used to change various styles and formatting options in a presentation.
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25. Write notes on Multimedia projectors.
v" Multimedia projectors are used to produce computer output on a big screen.
v These are used to display presentations in meeting halls or in classrooms.
26. What is a word length?
v" Word length refers to number of bits processed by a computer’s CPU.
v For example: a word length can have 8 bits, 16 bits, 32 bits and 64 bits.
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27. write notes on PROM.
v Programmable read only memory is also a non-volatile memory on which data can be written ony
once.
v Once a program has been written onto a PROM, it remains there forever.
v"Unlike the main memory, PROM s retain their contents even when the computer is turned off.
28. Write some names of the icons in Ubuntu OS.
Search your Computer
Files
Firefox Web browser
LibreOffice Writer
LibreOffice Calc
LibreOffice Impress
Ubuntu Software
Amazon
System Settings
Trash
29. Explain cell referencing.
v A cell reference refers to a cell or a range of cells on a worksheet and can be in a formula so that
OpenOffice Calc can find the values or data that you want that formula to calculate.
v Cell referencing are two types namely Relative cell referencing and Absolute cell referencing.
30. Explain the icons in the drawing tool bar.
i) Selecticon:
v This icon is used to select an object.
i)  Shapes icon:
v This icons used to draw a shapes such as line, ellipse, circle etc.
i) Font work gallery icon:
v This icon is used to change the font style like word Art.
iv) FErom file icon:
v This icon used to insert shapes from saved shapes from computer.
V) Extrusion On/Off icon:
31. How will you change lower case letter to upper case in a text?

This can be done by:
v' Select the text to change case
v" Select Format > Change case.
32. Differentiate KB, MB, and GB.
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KB MB GB
KB stands for Kilo Byte MB stands for Mega Byte GB stands for Giga Byte
1 KB is equal to 1024 Bytes 1 MB is equal to 1024 KB 1 GB is equal to 1024 MB

33. Define Master Slide.

v A slide master has a defined set of characteristics, including the background color, graphic, or gradient;
objects (such as logos, decorative lines and other graphics) in the background; headers and footers;
placement and size of text frames; and the formatting of text.
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34. Explain about Printers.
Printers:
v' Printers are used to print the information on papers.
v’ Printers are divided into two main categories: Impact Printers and Non-Impact printers
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Impact Printers:-
v These printers print with striking of hammers or pins on ribbon.
v These printers can print on multi-part (using carbon papers) by using mechanical pressure.
v For example, Dot Matrix printers and Line matrix printers are impact printers.
1. Dot Matrix Printer:-
v A Dot matrix printer that prints using a fixed number of pins or wires.
v Each dot is produced by a tiny metal rod, also called a “wire” or “pin”, which works by the power of a
tiny electromagnet or solenoid, either directly or through a set of small levers.
It generally prints one line of text at a time.
The printing speed of these printers varies from 30 to 1550 CPS (Character per Second).
Line matrix printer:-
Line matrix printers use a fixed print head for printing.
Basically, it prints a page-wide line of dots.
But it builds up a line of text by printing lines of dots.
Line printers are capable of printing much more than 1000 Lines per Minute, resulting in thousands of
pages per hour.
v These printers also uses mechanical pressure to print on multi-part (using carbon papers).
Non-Impact Printers:-
v" These printers do not use striking mechanism for printing.
They use electrostatic or laser technology.
Quality and speed of these printers are better than Impact printers.
For example, Laser printers and Inkjet printers are non-impact printers.
Laser Printers:-
Laser printers mostly work with similar technology used by photocopiers.
It makes a laser beam scan back and forth across a drum inside the printer, building up a pattern.
It can produce very good quality of graphic images.
One of the chief characteristics of laser printer is their resolution — how many Dots per inch (DPI).
The available resolution range around 1200 dpi. Approximately it can print 100 pages per
minute(PPM)
2. Inkjet Printers:

v"Inkjet Printers use colour cartridges which combined Magenta, Yellow and Cyan inks to create colo

tones.

v A black cartridge is also used for monochrome output.

v Inkjet printers work by spraying ionised ink at a sheet of paper.

v The speed of Inkjet printers generally range from 1-20 PPM (Page per Minute).
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Add: a) -2210+1510 b) 2010+2510

Answer:

a) -2210+1510= 11111011

b) 2010+2510= 00101101

35. Explain DVD.

v A DVD (Digital Versatile Disc or Digital Video Disc)is an optical disc capable of storing up to 4.7 GB
of data, more than six times what a CD can hold.

v The disc can have one or two sides, and one or two layers of data per side; the number of sides and
layers determines how much it can hold.

v" A 12 cm diameter disc with single sided, single layer has 4.7 GB capacity, whereas the single sided,
double layer has 8.5 GB capacity. The 8 cm DVD has 1.5 GB capacity.

OR
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List the advantages of Distributed Operating System.
Distributed Operating System:-
v’ This feature takes care of the data and application that are stored and processed on multiple physical
locations across the world over the digital network (internet/intranet).
v The Distributed Operating System is used to access shared data and files that reside in any machine
around the world.
v The user can handle the data from different locations.
v The users can access as if it is available on their own computer.
The advantages of distributed Operating System are as follows:
%+ A user at one location can make use of all the resources available at another location over the
network.
%+ Many computer resources can be added easily in the network
% Improves the interaction with the customers and clients.
< Reduces the load on the host computer.
36. Explain the mouse actions.

Action Reaction
Point to an item Move the mouse pointer over the item.
Click Point to the item on the screen, press and
release the left mouse button.
Right click Point to the item on the screen, press and

release the right mouse button. Clicking the
right mouse button displays a pop up menu
with various options.

Double-click Point to the item on the screen, quickly press
twice the left mouse button.
Drag and drop Point to an item then hold the left mouse

button as you move the pointer press and you
have reached the desired position, release the
mouse button.

OR

How will you cut a text in a document?
Cut a text:-
To cut a text from one location to another
Select the text to be moved
Click Ctrl + X or Cut Icon or Edit >Cut
The text is removed from the source location and placed in the clipboard
Take the insertion pointer to the new location to be moved and
Click Ctrl + V or Paste Icon or Edit > Paste
The required text is moved to the required location.
37. How will you insert cells in the worksheet?
To insert a new cell between two existing cells, just right-click on any existing cell
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v From the pop-up menu, select “Insert” option.

v" The “Insert Cells” dialog box appear with four options

i) Shift cells down ii) Shift cells right  iii) Entire row iv) Entire Column
v Any one of the four options is selected.

v’ Selecting “Shift cells down”, inserts a new cell in the present location and the existing cells are shifted
downwards.

V" Selecting “Shift cells right”, inserts a new cell in the present location and the existing cells are shifted
towards right.

e — —
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What are the characteristics of Microprocessor? Explain.
Characteristics of Microprocessors:-
v' A Microprocessor’s performance depends on the following characteristics:
a) Clock speed
b) Instruction set
c) Word size
a) Clock Speed:-
v Every microprocessor has an internal clock that regulates the speed at which it executes
instructions.
v The speed at which the microprocessor executes instructions is called the clock speed.
v" Clock speed is measured in MHz (Mega Hertz) or in GHz (Giga Hertz).
b) Instruction Set:
v A command which is given to a computer to perform an operation on data is called an instruction.
v' Basic set of machine level instructions that a microprocessor is designed to execute is called as an
instruction set.
v" This instruction set carries out the following types of operations:

* Data transfer * Arithmetic operations ¢ Logical operations * Control flow ¢ Input/output
¢) Word Size:

v Word size determines the amount of RAM that can be accessed by a microprocessor at one time
and the total number of pins on the microprocessor.
v" Total number of input and output pins in turn determines the architecture of the microprocessor.
38. Explain the five tabs in Impress windows workspace.
v The Workspace has five tabs: Normal, Outline, Notes, Handout, and Slide Sorter.
v" These five tabs are called View Buttons.
Normal view:-
v It is the main view for creating individual slides.
v Use this view to format and design slides and to add text, graphics and animation effects.
Outline view :-
v It shows topic titles, bulleted lists and numbered lists for each slide in outline format.
v"Use this view to rearrange the order of slides, edit titles and headings, rearrange the order of iten
in a list and add new slides.
Notes view:-
v’ Lets you add notes to each slide that are not seen when the presentation is shown.
Slide Sorter view:-
v It shows a thumbnail of each slide in order.
v Use this view to rearrange the order of slides, produce a timed slide show, or add transitions
between selected slides.
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Handout view:-
v’ Lets you print your slides for a handout.
v You can choose one, two, three, four, or six slides per page from Tasks pane - Layouts.
v' Thumbnails can be re-arranged in this view by dragging and dropping them.
OR

Explain EBCDIC.

v This is similar to ASCII Code with 8 bit representation. This coding system is formulated by
International Business Machine(IBM).

v The coding system can handle 256 characters. The input code in ASCII can be converted to EBCDIC
system and vice - versa.
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